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The Ribbon 
 

Microsoft Word 2010 has a large selection of formatting tools and options available for you to use. 

 

Formatting is related to the way that the characters and words that you type are arranged on the printed document. 

 

Most of these formatting options are found along the top of the window, or the “Ribbon” as Microsoft calls it. 

This is the Ribbon. It is currently set to the “Home” tab. On the “Home” tab, each of the buttons and drop down 

menus affects the formatting of your typed characters and words, in someway. 

  

Figure 1: The Ribbon 



 

 

Home Tab 

Clipboard 
 

This is the clipboard area of the Ribbon. These tools and buttons are useful when copying and 

pasting characters and words from other places. 

 

For instance, I can copy some characters and text from an Internet web site and paste it into this 

document using these tools and buttons. 

 

The following section has been copied from the Wikipedia article on Microsoft Office: 

 

Microsoft Office is a proprietary commercial office suite of inter-related desktop applications, servers and 

services for the Microsoft Windows and Mac OS X operating systems, introduced by Microsoft in 1989. 

Initially a marketing term for a bundled set of applications, the first version of Office contained Microsoft 

Word, Microsoft Excel, and Microsoft PowerPoint. Over the years, Office applications have grown 

substantially closer with shared features such as a common spell checker, OLE data integration and 

Microsoft Visual Basic for Applications scripting language. Microsoft also positions Office as a 

development platform for line-of-business software under the Office Business Applications brand. According 

to Forrester Research, as of June 2009, some version of Microsoft Office is used in 80% of enterprises, with 

64% of enterprises using Office 2007. 

  



 

 

Font 
 

This is the Font area of the Ribbon. These 

buttons and tools affect the way that 

characters and words appear on the printed 

document. 

 

 

For example, most of this document has been typed using a typeface (also called Font) called “Century Gothic” 

 
This section of text is typed using a different Font; this one is called Arial. 

 

Changing the Font of some text is really easy. Simply select the block of text that you would like to change (also 

called “Highlighting”), then choose a Font from the drop down menu in the Font section of the Ribbon. 

 

 

The number in the box next to the name of the font is the size of the font. This is measured in 6th„s of an inch. A size 

12 font measures 4.512mm in size. 

 

These two buttons increase and decrease the size of the font (respectively). 

 

This next button changes the case of the characters and words that you have typed. 

 

Case is related to capital letters. THIS SENTENCE IS TYPED IN UPPER CASE. 

whereas this sentence is typed entirely in lower case. 

This Sentence Is Typed In “Camel Case”; Which Means That The First Letter Of Every Word Is A Capital Letter. 

 

Clicking this button will show you the different options that you have for case formatting. Usually, you will use the 

top option (which is the default option), called “Sentence case.” 

 

This is a button that clears the formatting of a section of text. This will revert the 

formatting of a section of text back to the default format settings set up by Microsoft. 

This is very useful if you want to remove lots of different formatting effects on a whole 

section of text. 

 

This button allows you to add extra characters to a section of text to make it easier to 

read. This tool is only useful for documents that are meant to be read by people who 

have trouble reading typed words (for instance, people who suffer from Dyslexia). 

 

This button is used to draw a box around characters and words. Selecting some text, 

then clicking this button will draw a box around that text. 

 

For instance, this text has a box drawn around it. 

 

Underneath the Font box (on the second row of buttons), are a selection of buttons that are used to change the 

typography of the characters and words. 

 

This button is called “Bold”. This tool affects selected characters and words by 

emboldening them. This sentence has been emboldened; notice how the 

characters and words in this sentence appear darker and thicker than 

the others in this document. This is used to bring your attention to a 

very important sentence or block of text. 

 



 

 

This button is called “Italics”. The tool affects selected characters and words by leaning 

them to the right a little. This sentence has been italicised; notice how the characters 

and words in this sentence appear as if they are leaning to the right-hand side of the 

page. There is no standard usage for this formatting option. 

 

This button is called “Underline”. This tool draws a line underneath selected words and 

characters. This sentence has been underlined; notice how the characters and words in 

this sentence have a line drawn underneath them. This tool is used to make section 

headings immediately obvious. 

 

This button is called “Strikethrough”. This tool draws a line through selected words and 

characters. This sentence has been underlined; notice how the characters and words in 

this sentence have a line drawn through them. This tool makes it a little difficult to read 

some characters and words, but it is used in drafts of documents to mark sections that 

need to be deleted. 

 

This button is called “Subscript”. This tool makes selected words and characters smaller 

and prints them underneath other characters. This sentence has been underlined; notice how the characters and 

words in this sentence have a line drawn through them. This tool is used, mainly, in Mathematics and Science. 

 

This button is called “Superscript”. This tool makes selected words and characters 

smaller and prints them above other characters. This sentence has been underlined; notice how the characters 

and words in this sentence have a line drawn through them. This tool is used, mainly, in Mathematics and Science. 

 

This button is called “Text Effects”. This tool can draw coloured lines around the outside 

of characters and words. 

 

 

This button is called “Text Highlight Colour”. This tool highlights sections of text, much 

like how a real highlighter works. This sentence has been highlighted in yellow. 

 

This button changes the colour of the text. Up until this point the text has been coloured 

black. But this sentence has been coloured red. And this sentence has been coloured 

green. 

 

This button is called “Character Shading”. This tool allows you to shade behind 

characters and words in a document. It is a little like highlighting, but it doesn‟t make 

the text stand out as much as highlighting. This sentence has been shaded. 

 

This button is called “Enclose Characters”. This tool is used to draw a circle or a box 

around characters and words. This ○sentence contains □words with characters that have 

been ◇en closed separately. 

  



 

 

Paragraph 
 

This is the Paragraph area of the Ribbon. 

These buttons and tools affect the position of 

a paragraph. 

 

 

 

This first button is called “bullets”. This tool allows you to create a bullet-pointed list of 

items. For instance, different types of animal: 

 

 Avian 

 Mammal 

 Reptile 

 

This button is called “Numbering”. This tool allows you to create a numbered list of 

items. For instance, the steps involved to make a cup of tea are: 

 

1. Add water to kettle 

2. Turn kettle on 

3. Get a cup 

4. Put a tea bag in the cup 

5. Pour boiling water, from the kettle, into the cup 

6. Let the tea brew 

7. Remove the tea bag 

8. Add milk and sugar to taste 

9. Stir a little 

10. Wait for it to cool down a little 

11. Drink 

 

This button is called “Multilevel Numbering”. This tool allows you to add a numbered 

list of items, but with multiple levels. For instance: 

 

1) One of the thing in this list 

a) One of the two sub-items in this list 

i) More sub-items in this list 

(1) It goes on and on 

ii) Even more sub-items in this list. 

b) Another of the two sub-items in this list 

2) Another thing in this list 

 

These two buttons decrease and increase the indentations of a paragraph. This is useful 

for if you need to quote someone or something. 

 

This block of text looks like a quote from a book or website. 

The text goes all the way to the right-hand side of the page, 

but the left-hand side of the paragraph starts a few indents 

into the page. 

 

These two buttons change the orientation of the text. Currently, it is set as “Left-to-right 

Text Direction”. 

 

This sentence is set to “Right-to-Left Text Direction”. It is useful for typing in Arabic. 
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This button is called “Asian Layout”. It allows you to type a section of text vertically, 

rather than horizontally. 

 

This button is called “Sort”. This tool is used to alphabetise a list – putting the items 

within the list in alphabetical order. 

 

This button is called “Show/Hide”. This tool shows or hides paragraph formatting 

icons. These will not be displayed on the printed document, but they can be useful for 

tracking down errors in the formatting of your document. 

 

The next row of buttons changes the alignment of a paragraph. So far, in this document, the text has been aligned 

to the left-hand side of the page. This means that each line of text starts on the far left of the page. 

 

 

This sentence is aligned to the centre of the page. 

 

This sentence is aligned to the right of the page.  

 

This paragraph is justified. This means that both the left and right sides of the block of text are lined up 

with both sides of the page. This is different to left, centre or right aligned, because the characters and 

words have extra spaces between them to make this paragraph line up with the borders of the page. 

 

This button is called “Distributed”. This tool acts the same way as the justify tool, except 

that when this tool is selected, you begin typing in the centre of the page. This 

paragraph uses the “Distributed” tool. But sometimes you get gaps between the letters 

i n  e a c h  l i n e ,  a n d  s o m e t i m e s  y o u  d o n ‟ t .  L i k e  t h i s . 

 

This button is called “Lines and Paragraph Spacing”. It changes the amount of space 

between each of the lines in a block of text. So, far this document has used the 1.0 

setting. That means that each line has a gap of 1 line between each line. 

 

This paragraph has the setting 1.5. As you can see, the gap between each line is a little bigger than the gap in the 

previous paragraph. This is sometimes used in academic texts (text books) to make the lines of text easier to read 

for those who suffer with borderline dyslexia. 

 

This paragraph has the setting 2. As you can see, the gap between each line is a little bigger than the gap in the 

previous paragraph. There are sizes above this, but they are pretty useless. 

 

This button is called “Shading”. This tool along with the “Character Shading” tool is 

used to add a coloured background to areas of text. This tool changes the colour that is 

used by the “Character Shading” tool. 

 

This button is called “Borders”. This tool can be used to add a border (a line around) to 

a block of text. This is pretty useful if you want to draw the reader‟s attention to a 

paragraph. You will see these used in the “For Dummy‟s” series of books. This tool 

used to be called “Text Box” is old versions of Word. 

  



 

 

Styles 
 

This is the Styles 

area of the 

Ribbon. These 

buttons are 

shortcuts to other 

tools. 

 

These buttons and tools affect the way that the text appears on a printed document. However, they can be thought 

of as shortcuts (or convenience buttons) that change all of the other settings on the “Home” tab of the ribbon. 

 

So far in this document, I have used the “Heading 1” style 5 times; once each for the text at the beginning of each 

section. Since there is (potentially) no limit to the number of buttons and tools in this section, I won‟t cover them. 

 

The best way to learn about these buttons and tools is through “trial and error”. Try them out, and remember that 

Undo (go back one step) is your friend. 

 

Undo can be accessed by holding the Control key and pressing Z. 

  



 

 

Editing 
 

 

There are 3 tools in this section of the Ribbon. They are all easily explained by their names. 

 

 

 

 

Find searches through the document for a specific set of characters or words. 

 

Replace does the same as Find, but replaces those characters or words with other characters or words. 

 

Select selects blocks of texts within a document. 

  



 

 

Insert Tab 

The Insert tab has tools and buttons that can be used to add (or insert) things to a document. Most of the things you 

can add (collectively called “Objects”) are in the form of built-in objects – like Charts, Graphs, Headers & Footers, 

Word Art or special symbols. 

  

Figure 2: The Insert Tab 



 

 

Pages 
 

 

 

This is the Pages area of the Ribbon. These buttons are used to add special types of 

pages to a document. 

 

 

 

 

This first button is the “Cover Page” button. This tool can be used to add special types 

of cover pages to a document. These are particularly useful if you are writing a book. 

But this is NOT useful if you are writing an academic paper (I.E a dissertation or an 

essay) as you will be told what kind of cover page to add, by your tutor/lecturer. 

 

This second button is the “Blank Pages” button. This tool is used to add a blank page in 

the middle of a document. This is useful for writing books and novels, as most chapters 

in a book or novel start on a right-hand (or even numbered) page. 

 

 

This button is a “Page Break” button. This tool is used to jump straight to the next page 

in the document. Each time that I have talked about a new area of the Ribbon in this 

document, I have used a page break. Here comes another one. 

 

  



 

 

Tables 
 

This is the Tables area of the Ribbon. It is used to add a table to your document. 

 

Simply clicking on this button will bring up the Table wizard, which will guide you through adding a 

table to your document. 
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Illustrations 
 

This is the Illustrations area of the Ribbon. These 

tools and buttons are used to add pictures, shapes 

and other images to your document. 

 

 

 

This first button is the “Picture” button. This tool is used to add pictures that are stored 

on your computer to a document. All of the pictures in this document were added using 

this button. 

 

 

 

This button is the “Clip Art” button. Clip Art are images provided by Microsoft that you 

can add to your documents. Usually, these are pretty cheesy and of low quality. 

 

 

 

This button is the “Shapes” button. This tool is used to add “hand-drawn” shapes to a 

document. The following are shape examples, drawn using this tool. 

 

 

 

 

This button is the “Smart Art” button.  This tool is used to add picto-graphic information; 

such as Flow or Gantt charts, Picture lists, and Cycle matrices. The following is an 

example of a Cycle Martix. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This button is the “Chart” button. This tool is used to add different types of mathematical 

graphs and charts to a document. When you add a chart to your document, you will 

have to supply Word with some data for it to plot in that chart. 

 

This button is the “Screenshot” button. This tool is used to add an image of what‟s 

happening on your screen to the document. This is useful if you are typing a document 

about a piece of software, and want to include a picture of what‟s happening along 

with a description. 

  



 

 

Links 
 

 

This is the Links area of the Ribbon. These tools and buttons are used to add web-links, 

bookmarks and references to your document. 

 

 

 

 

This first button is the “Hyperlink” button. This tool can be used to add links to websites 

or files on your computer to your document. 

 

This button is the “Bookmark” button. It can be used to add bookmarks to a document; 

these make it easier to move around the document. 

 

This  button is called the “Cross Reference” button. This tool is used to add references to 

other areas in the document, such as “See table 7” or “See page 15”. These cross 

references automatically update themselves, too. 

  



 

 

Header & Footer 
 

 

This is the Header & Footer area of the Ribbon. These tools and buttons are used to 

add headers, footers and page numbers to your document. 

 

 

 

 

This first button is the “Header” button. This tool is used to add characters and text to 

the area within the upper margins of the document. 

 

 

 

This button is the “Footer” button. This tool is used to add characters and text to the 

area within the lower margins of the document. 

 

 

 

 

This button is the “Page Number” button. This tool is used to add page numbers to each 

of the pages in a document. 

 

 

  



 

 

Text 
 

This is the Text area of the Ribbon. 

These tools and buttons are used to 

insert specific text options to your 

document. 

 

 

 

This first button is the “Japanese Greetings” button.  This tool is used to add Japanese 

greetings to a document. Unless you are writing a document for Japanese people to 

read, AND you can read Japanese, then this is a useless tool. 

 

 

This button is the “Text Box” button. This tool is used to add text inside of a moveable 

box to your document. This can be useful if the text you are adding to a document 

needs to be in lots of different places on a document. 

 

 

 

This button is the “Quick Parts” button. This tool is used to add common blocks of text to 

a document. These common blocks of text include things like the author name, publisher 

name, title, page numbers and many others. 

 

 

 

This button is the “Word Art” button. This tool is used to add decorative text into your 

document. These are very fancy looking pictures that are made up of text. 

 

The following is a piece of Word Art: 

 

 

 

This button is the “Drop Cap” button. This tool is usually “greyed out”; which means 

that it isn‟t in colour. If a tool is greyed out, then it is not useable just yet. For this tool to 

be useable, you must select some text first. 

 

 

he whole point of the Drop Cap tool is to make the very first letter of a paragraph very big. This is an old 

typography technique. It was once used by Monks who would hand-copy pages of the bible. They would, usually, 

add a picture within the first letter that would show what was happening in that section of the story. Also, this 

paragraph has a Drop Cap at the beginning of it. 

 

This button is the “Signature Line” button. This tool is used to automatically add a 

“signature” to the end of a document. This tool is often used by businesses, as it would 

be impossible for a manager to sing every single letter that is sent out by the company. 

 

This button is the “Date & Time” button. This tool is used to automatically add (and 

update) the date and/or time to a document. This is useful if you are writing a letter that 

will take you a few days to complete. 

 

This button is the “Object” button. This tool is used to add anything that is not added by 

any of the other buttons on the Insert Tab.  

T 



 

 

Symbols 
This is the Symbols area of the Ribbon. These tools and buttons are used to insert specific 

characters that may not appear on your keyboard into your document. 

 

 

 

 

This is the “Equation” button. This tool is used to add Mathematical and Scientific 

equations to your document. There are lots of templates to use, or you can type your 

own. 

 

 

This is the “Symbol” button. This tool is used to add specific symbols or characters – 

that may not be listed on your keyboard – to your document. It uses the full ASCII table, 

so you can add many characters that are outside of the Latin character set; such as 

Greek (ζ), Cyrillic (Њ) or Musical (♫) 

  



 

 

Page Layout Tab 

The Page Layout tab has tools and buttons that can be used to edit the layout and formatting of the page. These 

tools can change the colour of the background, add or remove columns, change the size of the page and alter the 

direction of the text. 

  

Figure 3: Page Layout Tab 



 

 

Themes 
 

 

This is the Themes area of the Ribbon. These buttons are used to change the styles used 

throughout the entire document with the press of a single button. 

 

 

 

This first button is the “Themes” button. This tool is used to change the style of the entire 

document in one click. By “Style” we mean the type face and size (a Font is a type face 

AND a size); the colour of the text; any bold, underlined or italicized formatting and 

line spacing. 

 

 

This button is the “Colours” button. This tool is used to change the colour of all of the 

text in a document with only one button press. 

 

This button is the “Fonts” button. This tool is used to change all of the fonts (type face 

and size) used in the document with only one button press. 

 

This button is the “Effects” button. This tool is used to change all of the font effects (Bold, 

Underline, Italics, Line spacing, etc.) used in the document with only one button press. 

  



 

 

Page Setup 
This is the Page Setup area of 

the Ribbon. These buttons are 

used to change various settings 

that are related to the pages of 

your document. 

 

This first button is the “Text Direction” button. This tool is used to change the direction of 

some selected text. The options available are Horizontal, Vertical and Rotated Text. 

We‟ve already seen horizontal text (what most of this document is written in), and 

vertical text can be seen on page 7. The other option, Rotated Text, is only available 

when Asian characters are present in the document. 

 

This button is the “Margins” button. This tool is used to alter the size of the margins for 

all of the pages in your document. A margin is the invisible space at the sides and top 

and bottom of your document that you cannot type into. Altering these margins allows 

you to have more or less text on the page. So far, in this document, I have used very 

small margins (1.2cm on all sides). The default margins are 2.5 cm on all sides. 

 

This button is the “Orientation” button. This tool is used to change the orientation of a 

page in your document. It can be used to rotate an entire page from Portrait (how this 

document is laid out) to Landscape (by rotating the page 90˚ to the right). 

 

 

This button is the “Size” button. This tool is used to change the size of the paper used 

for your document. There are a lot of templates here, but the most useful one is A4 

(which is what this document is printed on). 

 

 

This button is the “Columns” button. This tool is used to add columns to a document. 

Magazines and newspapers are usually written with 3 to 5 columns each page. 

 

 

 

This button is the “Breaks” button. This tool is used to add breaks to the text on a 

document. These can be Page Breaks (covered on page 12), or columns breaks. You 

can even have Word place a break between the current page and the next even or 

odd page (useful when writing a text book or novel). 

 

This button is the “Line Numbers” button. This tool is used to add line numbers to the 

entire document, or sections of text. This is useful for legal-type documents, agendas or 

policies. 

 

This button is the “Hyphenation” button. This tool is used to edit the options relating to 

hyphenation. This is a hyphen “–. It is used to link specific types of words together; 

words such as “American-Football,” “One-Sixth,” or “Well-Respected” (these are known 

as compound modifier). 

  



 

 

Page Background 
This is the Page Background area of the Ribbon. These buttons are used to 

change various settings that are related to the pages of your document. 

 

 

 

 

 

This first button is the “Watermark” button. This tool can be used to add faint text to the 

background of each page. This can be used to let the reader know that they are 

reading a confidential document, or that they are not allowed to copy the document.  

 

 

This button is called the “Page Colour” button. This tool is used to change the colour of 

the background of an entire page. Be careful when using this tool though, as a change 

in background colour will be printed and this might use a lot of printer ink. If you want 

a document (or a page of a document) to have a different background colour, it might 

be better – and cheaper – to print it on coloured paper. 

 

This button is the “Page Borders” button. This tool is used to add line borders to the 

pages of your document.  

 

 

 

  



 

 

Paragraph 
This is the Paragraph area of the Ribbon. These 

buttons are used to change various settings that are 

related to line spacing and paragraph indenting. 

 

 

 

 

These first buttons are the “Indent” buttons. These tools are used to alter the indentation 

of whole paragraphs or blocks of text. The indentations can be on either the left or the 

right-hand side of the page. Increasing the indentation on the left-hand side of the 

paragraph will “move” the text further towards the centre of the page. Conversely, 

moving the right-hand side indentation will “move” the text further towards the centre of 

the page. 

 

These buttons are the “Spacing” buttons. These tools are used to alter the size of the 

space between each of the lines in a paragraph. Unlike the spacing button on the 

Home tab (see: page 8), these buttons let you “fine tune” the spacing before and after 

each line. 

 

  



 

 

Arrange 
This is the Arrange area of the Ribbon. 

These buttons are used to edit how 

images, text boxes and graphs are 

arranged throughout your document. 

 

 

It is best to think of your document as a 

pile of objects that sit on top of a piece of paper. These objects can be re-arranged before they are printed onto 

paper. Objects (text, images, etc.) can sit next to each other or on top of each other. Sometimes you will want one 

object to appear on top of other objects. These tools are only available when you select an object (an image, a 

graph, etc.) 

 

This first button is the “Position” button. This tool allows you to edit the position of an 

object (an image, a graph, etc.). There are a lot of pre-set options for you to choose 

from and these can be very useful in arranging objects within a document. 

 

 

This button is called the “Wrap Text” button. This tool allows you to change the way 

that text is wrapped around an object within your document. So far, in this document, I 

have used the “Tight” option. This places other objects (such as text) as close to the 

image as is possible. 

 

 

This button is called the “Bring Forward” button. This tool allows you to re-arrange the 

stack of objects on a page. Remember that I mentioned that until a page is printed, 

everything appears on the document in a stack or pile? Well, this is the tool you can 

use to bring things from the bottom (or within) the pile toward the top of the pile. 

 

This button is the “Send Backward” button. This tool allows you to do the opposite of 

the Bring Forward button – it moves objects further down the stack or pile, until they 

reach the bottom. 

 

 

 

 

This button is the “Selection Pane” button. This tool brings up a small window (called a 

Pane) showing you all of the movable objects on the page of the document that you are 

looking at. Imagine that you have 4 objects sitting on top of each other, and you want 

to move the one at the bottom all the way up to the top; this tool allows you to select the 

object you want without having to worry about selecting other objects on the page. 

 

This button is called the “Align” button. This tool is used to align objects to certain areas 

of the page. It is very similar to the align buttons found on the Paragraph areas of the 

Home Tab (See page 8), except that it works with objects instead of text. 

 

This button is called the “Group” button. This tool is used to group objects together. 

Selecting (clicking) on one of the objects in the group will select them all. This is useful if 

you are performing the same operation on all of your objects. 

 

This button is the “Rotate” button. This tool can be used to rotate objects (or groups of 

objects). It can also be used to flip objects horizontally or vertically. 



 

 

 References Tab  

The References tab has tools and buttons that can be used to add references to other documents, books or web 

sources; a table of contents; bibliographies (lists or test books or other sources of information) and captions into 

your document. 

 

  

Figure 4: References Tab 



 

 

Table of Contents 
This is the Table of Contents area of the Ribbon. These buttons are used to add 

a table of contents to your document. This can make it easier for the readers of 

your document to find specific sections of it. 

 

 

 

 

This first button is the “Table of Contents” button. This tool allows add a table of 

contents to the beginning of your document. There are many different styles for you to 

choose from and each one is slightly different. The table of contents at the beginning of 

this document was added by pressing this button. 

 

 

This button is called the “Add Text” button. This tool is used to add text and characters 

to your table of contents. It allows you to edit the text on each “level” of the table of 

contents. 

 

This button is called the “Update Table” button. This tool is used to automatically 

update your table of contents. It‟s worth using this tool every time that you make a big 

change to your document or before you save the document. 

 

  



 

 

Footnotes 
This is the Footnotes area of the Ribbon. These buttons are used to add extra 

notes to the bottom of specific pages to your document. This allows you to 

add more detail to your document that readers can choose to read if they 

wish. 

 

 

 

This first button is called the “Insert Footnote” button. This tool is used to add footnotes 

to the end of a page. For instance, if you look at the bottom of this page, you will find 

a footnote.1 

 

 

 

This button is called the “Insert Endnote” button. This tool is very similar to the Insert 

Footnote tool, except that an Endnote is placed at the very end of the document, rather 

than at the bottom of the current page. 

 

This button is called the “Next Footnote” button. This tool is used to move around the 

document, focusing on each of the footnotes in the document. 

 

This button is called the “Show Notes” button. This tool is used to move directly to the 

next set of footnotes in the document. 

 

  

                                                 
1
 This is a footnote. It has been added to this page to demonstrate what footnotes are. They are quite useful if you need to either add 

more information/clarification or mention the source of some kind of information. 



 

 

Citations and Bibliography 
This is the Citations and Bibliography area of the Ribbon. These buttons are 

used to add extra notes to the bottom of specific pages to your document. 

This allows you to add more detail to your document that readers can 

choose to read if they wish. 

 

 

 

 

This first button is the “Insert Citation” button. This tool is used to cite (reference) a 

book, article, journal or website. For example, the following in a citation for a book 

called “The Fry Chronicles: An Autobiography” by Stephen Fry: (Fry, 2011). 

 

The only problem is that you need to have a bibliography section set up, so that you 

can see the names of the documents that you cite. (If you check the end of this 

document, you should find a bibliography section) 

 

This button is called the “Manage Sources” button. This tool is used to add or remove 

the sources that you cite in your document. 

 

This button is called the “Citation Style” button. This tool is used t change the style used 

for citations in your document. If you are writing an academic paper (where citations 

are used the most), then you should already know the citation style you need. If not, 

then you should as the person who has set you the paper. 

 

This button is called the “Bibliography” button. This tool is used to add a bibliography 

(including all of the references you have cited) into your document. If you look at the 

end of this document, you will find a bibliography. 

 

 

  



 

 

Captions 
This is the Captions area of the Ribbon. These buttons are used to add 

captions and tables of figures to your document. 

 

 

 

 

 

 

This first button is the “Insert Caption” button. This tool is used to add captions to an 

image. Captions are small amounts of text directly under and image, usually they 

contain a description of the image. 

 

You should notice that each image of a tab (at the beginning of each section) has a 

caption underneath it. 

 

This button is called the “Insert Table of Figures” button. This tool is used to add a table 

of figures to your document. A table of figures is very similar to a table of contents, 

except that it only lists the figure (images, illustrations, equations, etc.) in the document. 

 

This button is called the “Update Table” button. This tool is used to update your table of 

figures. It works in the same way as the update table button found in the table of 

contents area of the References tab 

 

This button is called the “Cross Reference” button. This tool is used to add references to 

other areas in the document, such as “See table 7” or “See page 15”. These cross 

references automatically update themselves, too. 

 

  



 

 

Index 
This is the Index area of the Ribbon. These buttons are used to add indexes to your 

document. An index is similar to a table of contents, except that they list keywords 

rather than section headings. 

 

 

 

 

 

This first button is called the “Mark Entry” button. This tool is used to add a selection of 

text to the index of your document. To add something to your index, you select it then 

press this button. 

 

 

 

 

This button is called the “Insert Index” button. This tool is used to add an index to your 

document. However, you need to use the Mark Entry tool to add things to the index. 

 

This button is called the “Update Index” button. This tool is used to update the index 

that you have added to your document. As with the update table buttons in the Table of 

Contents area (see page 28) and the Captions area (see page 31), it is useful to use 

this tool every time that you make a change to your document and before you save. 

 

  



 

 

Table of Authorities 
This is the Table of Authorities area of the Ribbon. These buttons are 

used to tables of authorities to your document. The most common use 

for a table of authority is a legal document; they are very similar to a 

table of contents, except that they track all of the citations you have 

used throughout your document. 

 

This first button is the “Mark Citation” button. This tool is used to add specific citations 

to your table of authorities. It is used in the exact same way as the Mark Entry button 

(see page 32) in the Index area of the References tab. 

 

 

 

This button is called the “Insert Table of Authorities” button. This tool is used to add a 

table of authorities to your document. It works in a similar way to the Table of Contents 

button (see page 28) on the References tab. 

 

This button is called the “Update Table” button. This tool is used to update your table of 

authorities. As with the update table buttons in the Table of Contents area (see page 

28) and the Captions area (see page 31), it is useful to use this tool every time that you 

make a change to your document and before you save. 

  



 

 

Mailings 

This is the Mailings area of the Ribbon. These buttons are used to automatically set up mailing options for your 

document. These options include things like automatically adding names and addresses and greetings. 

 

These tools and options can be useful if you are sending a single document to many different people at different 

addresses. The mailing tools and options can automate the process of adding names, greetings and signatures to 

any documents that you are sending. 

 

 

  

Figure 5: Mailings Tab 



 

 

Create 
 

This is the Create area of the Ribbon. These buttons are used to 

add sections and formatting specific to letters. 

 

 

 

 

 

This first button is the “Japanese Greetings” button. This tool is used to add Japanese 

greetings to documents and letters. 

 

An example would be: 秋雨の候、貴社ますますご盛栄のこととお慶び申し上げます。

平素は格別のご高配を賜り、厚く御礼申し上げます。Which roughly translates to: 

“Season of autumn rain, We and our pleasure that our more elite company. Bestowed 

the good offices of our normal circumstances are exceptional, Thank you very.” 

 

Clearly, this tool is only useful if you can read and understand Japanese text. 

 

This button is the “Japanese Postcard” button. This tool is used to create Japanese style 

postcards. 

 

This tool will be “greyed out” or un-selectable, however, unless you have both a 

Japanese keyboard AND the Japanese language installed on your machine. As with 

the Japanese Greetings tool, this tool is absolutely useless to most users who are not 

Japanese. 

 

This button is the “Envelopes” button. This tool is used to create, format and print 

envelopes. This does require you to have envelopes that you can print onto, however. 

 

 

This button is the “Labels” button. This tool can be used to create, format and print 

labels. This is useful if you do not have envelopes that cannot be printed on, or that 

cannot be passed through your printer. There are many options and template sizes for 

common label types – you will need to look on the packaging of your sheet of labels to 

find out the size name (we use L6172 at ARKH) and choose that from the list of 

available sizes. 

 

  



 

 

Start Mail Merge 
This is the Start Mail Merge area of the Ribbon. These buttons are used 

when beginning a mail merge. They allow you to add multiple 

recipients (people who will receive your document), in many different 

forms, to your document. 

 

 

 

This first button is the “Start Mail Merge” button. This tool is used to begin the process 

of a mail merge. A mail merge can be used on letters, envelopes, labels and E-Mail 

messages. 

 

It is essential that this tool be used before other mail merge tools, as this tells Word that 

you want to create a mail merged document. 

 

This button is the “Select Recipients” button. This tool is used to add recipients to your 

mail merged document. Recipients can be added via typing them in manually, an Excel 

spread sheet, an Access database, or even a simple text file. 

 

 

 

This button is the “Edit Recipients List” button. It is used to add or remove recipients 

after you have selected them using the Select Recipients tool. This is useful if you realise 

that you have left someone out or have forgotten to add someone to your list of 

recipients. 

 

 

  



 

 

Write & Insert Fields 
 

This is the Write & Insert Fields area of 

the Ribbon. These buttons and tools are 

to add specific blocks of text (called 

“Fields”) to your document. These 

include addresses and greetings. 

 

This first button is called the “Highlight Merge Fields” button. It is used to help you to 

see which parts of the document you have added as a merge field (such as the address 

block, or a greeting) so that you don‟t remove them when editing your document. 

 

 

 

This button is called the “Address Block” button. It is used to add a special field called 

the Address Block. This means that you don‟t have to type addresses into your 

document for every single recipient. 

 

 

 

This button is called the “Greeting Line” button. It can be used to automatically add 

specific greetings to your document for each of the recipients. 

 

 

 

This button is called the “Insert Merge Field” button. This tool, like the others in this 

area, is used to add merge fields to your document. However, this tool can add more 

than just names or addresses; it can add telephone numbers or company names. 

 

 

 

This button is called the “Rules” button. This tool is used to edit the rules around mail 

merge. Normally, Word will step in and start automatically formatting and inserting 

merge fields for you, but this tool allows you to change how Word does that. 

 

This button is the “Match Fields” button. This tool allows you to customise the names of 

fields. The names of fields won‟t be printed, but are used to look up the information 

from your list of recipients. Mostly, this tool is useless. 

 

This button is the “Update Labels” button. It is used to update all the fields that you are 

using, fi you are creating labels. 

 

  



 

 

Preview Results 
 

This is the Preview Results area of the Ribbon. These buttons and tools 

are used to allow you to check your mail merge document before you 

merge and print it. 

 

 

 

 

This first button is called the “Preview Results” button. This tool is used to build a 

working preview of your mail merged document. Up until pressing this button, there will 

be sections of the document that will have “placeholder text” which will look like this: 

“Dear <<name>>,” 

 

When the Preview Results tool is used, each piece of placeholder text is replaced with 

real values from your list of recipients. 

 

This area of buttons is the “Record Selection” area. These tools are used to switch 

between each of the recipients in your list of recipients, when the Preview Results tool 

has been used. 

 

This button is called the “Find Recipient” button. This tool, along with the previous tools 

(“Record Selection”), is used to find a specific recipient from your list of recipients.  

 

This button is called the “Auto Check for Errors” button. This tool is used to change the 

way that Word handles any errors that occur when you finalise your mail merge. It can 

also be used to simulate a full mail merge, allowing you to see if there will be any 

errors 

 

  



 

 

Finish 
 

 

This button is the “Finish & Merge” button. The tool is used when you are finished with you mail 

merged document. This replaces all of the placeholder text with actual records from your recipient list, 

and creates copies of the document ready for printing. 

 

 

 

  



 

 

Review 

This is the Review area of the Ribbon. These buttons are useful for proofing your document. This means checking the 

spelling and grammar, and setting the language of the document. Also, these tools allow you to add comments 

(which will not be printed), and compare the current version of your document to older versions. 

 

 

  

Figure 6: Review Tab 



 

 

Proofing 
 

This is the Proofing area of the Ribbon. These buttons and tools are used to allow 

you to check the spelling and grammar of your document. There is also a 

thesaurus tool and a word count tool. 

 

 

 

 

 

This first button is the “Spelling & Grammar” button. This tool is used to check the 

spelling and grammar of your document. For this tool to work correctly, you need to 

make sure that Word knows which language you are typing your document in. 

 

To make sure that Word knows which language you are typing your document in, 

press the “Spelling & Grammar” button and the following dialogue box will appear. 

Make sure that the bottom “Drop Down” menu says “English (UK)” – as it does in the 

image below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This button is the “Research” button. This tool is used to research things without having 

to leave Word. Without this tool, you would have to find a textbook or a website that 

contained the information you need. The only down side to using this tool is that you 

need to be connected to The Internet to use it. 

 

This button is the “Thesaurus” button. This tool works exactly the same way as a 

physical Thesaurus. A thesaurus is a book that allows you to find words that have 

similar meanings to other words; for instance “Fire” and “Conflagration”. 

 

This button is the “Word Count” button. This tool is used to count the amount of words, 

characters, spaces, pages, lines and paragraphs in your document. This is really useful 

if you have a word limit (for an essay, etc.). 

 

  

Figure 7: Spellcheck Dialogue 



 

 

Language 
 

This is the Language area of the Ribbon. These buttons and tools are used to change 

the language that Word thinks the document is typed in. 

 

 

 

 

This first button is the “Translate” button. This tool allows you to translate a word, 

sentence, paragraph or an entire document from one language to another. This is, 

however a machine translation, and as such is pretty bad. It will give you a general 

idea, but not a perfect translation. 

 

Note: This tool only translates from English (US). Some words are spelt differently in 

English (US) than in English (UK). 

 

This button is the “Language” button. This tool allows you to change the “Proofing 

Language” (the language that Word thinks your document is typed in) to any other 

language that Word supports (around 50-70 languages). 

 

However, you will have to install the language that you want to use BEFORE you can 

use it, and this requires you to be connected to The Internet 

  



 

 

Comments 
 

This is the Comments area of the Ribbon. These buttons and tools are 

used to add comments to documents. These comments will not be 

printed, but can be useful when editing or adding to a document. 

 

 

 

 

This first button is called the “New Comment” button. This tool is used to add a 

comment to your document. These can be very useful as reminders for things that you 

need to add, change or take away from your document. They can also be useful for 

other readers of your document, especially if you have confusing tables or formulae in 

your document. 

 

Note: Any notes in your document will NOT be printed. 

 

This button is called the “Delete Comment” button. This tool can be used to delete 

specific comments from your document. 

 

 

 

 

This button is called the “Previous Comment” button. This button is used to move 

backwards through the comments in your document. 

 

 

 

This button is called the “Next Comment” button. This tool is used to move forwards 

through the comments in your document. 

 

 

 

  



 

 

Tracking 
 

This is the Tracking area of the Ribbon. These buttons and 

tools can be used to track any and all changes that you make 

to your document. For these tools to work, you must enable 

them BEFORE beginning to type out your document 

 

 

 

This first button is the “Track Changes” button. This tool is used to track any and all 

changes that you make to your document. This can be useful if you delete something 

that you later regret deleting, as this will allow you to replace what you have deleted 

with the click of a button. 

 

Note: This has to be selected BEFORE you begin typing your document. 

 

This button is the “Display for Review” button. This tool is used to display the different 

versions of your document (supposing that you have already enabled the “Track 

Changes” tool). 

 

This button is the “Show Markup” button. This tool is used to change the details that are 

shown when the different “Display for Review” options are chosen (supposing that you 

have already enabled the “Track Changes” tool). 

 

This button is the “Reviewing Pane” button. This tool creates a pane (small window) on 

the left-hand side of the screen, which will show you all of the changes that you have 

made to your document (supposing that you have already enabled the “Track 

Changes” tool).  

 

  



 

 

Changes 
 

This is the Changes area of the Ribbon. These tools are used to accept or reject 

changes that other people have made to your document. This is useful if you 

collaborate (work together with) with other people on a single document. Each 

user will make changes to the document, and Word will keep a log of them, it 

is up to you whether these changes become permanent or not. 

 

Note: For these tools to take affect, each person who makes changes to your 

document HAS to have set Word up fully (including setting a username, telling Word their actual name, and 

providing a company name). If they haven’t done this, then the changes will NOT be kept. 

 

This first button is the “Accept Changes” button. This tool is used to accept changes that 

other people have made to your document. 

 

 

 

 

This button is the “Reject Changes” button. It is used to reject changes that other people 

have made to your document. 

 

 

 

 

This button is the “Next Change” button. This tool is used to move forwards through the 

changes that other people have made to your document. 

 

This button is called the “Previous Change” button. This tool is used to move backwards 

through the changes that other people have made to your document. 

 

  



 

 

Compare 
 

 

This is the Compare area of the Ribbon. This area only has one tool and it is used to 

allow you to compare the current version of your document against an older version or 

combine two versions of your document (assuming that you have used the “Track 

Changes” button – See page 44) 

 

 

 

  



 

 

Protect 
 

 

This is the Protect area of the Ribbon. These tools can be used to protect your document 

from being edited by other people. 

 

 

 

 

 

This first button is the “Block Authors” button. This tool is used to stop certain people 

from editing or adding to your document. 

 

Note: For this tool to take affect, each person who can view your document HAS to 

have set Word up fully (including setting a username, telling Word their actual name, 

and providing a company name). If they haven‟t done this, then they will be able to 

make changes to your document. 

 

This button is the “Restrict Editing” button. This tool can be used to block everyone who 

will view your document from editing certain things; such as formatting (see page 4), 

entering text or deleting text. 

 

 

 

 

  



 

 

View 

This is the View area of the Ribbon. These buttons are useful for changing the current view of your document. This 

can help with arranging the objects on the document. 

 

 

 

  

Figure 8: View Tab 



 

 

Document Views 
 

This is the Document Views area of the Ribbon. These tools 

are used to change the way that you view your document. 

 

 

 

 

 

This first button is the “Print Layout” button. This tool switches the current view mode to 

the Print Layout. This view allows you to see as the document as it will look once it has 

been printed. 

 

The chances are that your version of Word has this as its default view. If you can see 

the page, the edges of the page and the rulers and margins then you are looking at 

your document‟s print layout. 

 

This button is the “Full Screen Reading” button. This tool switched the current view 

mode to Full Screen View. This allows you to read a document in full screen, allowing 

the document to take up as much screen space as possible. 

 

 

 

 

This button is the “Web Layout” button. This tool switches the current view mode to 

Web Layout. This allows you to view a document as if it were a website. 

 

 

 

 

This button is the “Outline” button. This tool switches the current view mode to Outline. 

This view mode just shows any headers and text. It does not show any formatting, or 

images/objects. 

 

 

 

This button is the “Draft” button. This tool switches the current view mode to Draft. This 

view mode is a combination of Web Layout and Outline, in that the document is 

displayed as if it were a website, but with no formatting or images/objects. 

 

 

  



 

 

Show 
 

This is the Show area of the Ribbon. There are three tick boxes here, which are only 

available when the current view mode (see page: 49) is set to Print Layout, Web Layout 

or Draft. Placing a tick into each of the tick boxes enables a feature. 

 

 

 

 

The ruler tick box enables or disables the ruler function. The ruler sits at the top of each page on all three views. 

This is useful as it will help you to arrange objects on your document. 

 

The gridlines tick box enables or disables the gridlines function. This places a graph-like grid over the page to help 

you arrange objects n your document (this will not be printed). 

 

The navigation pane tick box enables or disables the navigation pane. This is similar to the Reviewing Pane (see 

page 44), except that it does not list changes that you make to the document.  

 

  



 

 

Zoom 
 

This is the Zoom area of the Ribbon. These tools are used to zoom in to and 

out of the document, making it easier to read the document without altering 

the formatting of any text or objects. 

 

 

 

 

This first button is the “Zoom” button. This tool allows you to set the zoom level of your 

document.  

 

 

 

 

This button is the “100% Zoom” button. This tool enables you to “snap back” to 100% 

zoom (the default zoom level when you create a document) 

 

 

 

This button is the “One Page” button. This tool sets the zoom level so that one page 

takes up the entire window space. 

 

This button is the “Two Pages” button. This tool sets the zoom level so that two pages 

take up the entire window space. 

 

This button is the “Page Width” button. This tool sets the zoom level so that the width of 

a page matches the width of the window space. 

 

  



 

 

Window 
 

This is the Window area of the 

Ribbon. These tools are used to 

arrange any open word 

windows. 

 

 

 

Every program in a modern Operating System works in a Window of its own. Word has its own window system, 

Explorer has its own window system, Google Chrome has its own window system, etc. This is where the Windows 

operating system got its name. 

 

Each of these windows can be manipulated around the screen, and these are the tools that you can use to 

manipulate them. 

 

This button is the “New Window” button. This tool is used to open a copy of the current 

document in another window. 

 

 

 

 

 

This button is the “Arrange All” button. This tool is used to arrange all open Word 

windows. This will place one window at the top of the screen and any other windows 

at the bottom of the screen. 

 

 

 

 

This button is the “Split” button. This tool allows you to decide how you would like the 

screen divided (or split) amongst each of your open Word windows. 

 

 

 

 

This button is the “View Side by Side” button. This tool is used to show all of your open 

Word windows side by side. 

 

This button is the “Synchronous Scrolling” button. This tool allows you to scroll through 

two (or more) Word windows at the same speed. You MUST enable “View Side by 

Side” to do this, though. 

 

This button is the “Reset Window Position” button. This tool allows you to set a 

window‟s position back to its default one. 

 

  



 

 

Macro 
 

This is the Macros area of the Ribbon. There is only one tool here, but this tool can be 

very useful. 

 

A macro is a small program that performs a common task (usually that takes more than 

a few seconds to perform) in very little time, at the push of a button. You should be 

used to using macros by now; keyboard shortcuts Macros, as are desktop shortcuts. 

 

Macros in Word (and indeed the whole of Office) perform specific common tasks 

(usually formatting ones) at lightening speed. 

 

To create a task, you need to record yourself doing on then name it. After that, you can 

run that Macro at any time. 
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